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Protein Ligand Docking 

About this Lesson: 

Determining the binding mode of an active molecule to a given protein target is 

important in the drug discovery pipeline. This lesson will focus on reproducing an 

experimentally observed binding mode through docking.  

 

Using Maestro, students will learn how to import a .pdb file of a crystal structure, prepare 

a protein and ligand, as well as dock a ligand into a protein receptor using Schrödinger’s 

Glide. They will also analyze protein-ligand interactions from a Ligand Interaction 

Diagram.  

Learning Objectives: 

●​ Define molecular docking and explain why it is used in drug discovery 

●​ Prepare ligand and protein structures in Maestro 

●​ Learn the steps of a molecular docking workflow using Schrödinger’s Glide 

●​ Analyze integral protein-ligand interactions within an active site using the Ligand 

Interaction Diagram 

Lesson Contents: 

1.​ Setting Up the Maestro Session 

2.​ Introduction to Protein Ligand Docking 

3.​ Preparing Protein Structures 

4.​ Preparing a Ligand Structure 

5.​ Generating a Receptor Grid 

6.​ Docking the Cognate Ligand with a Hydrogen-Bond Constraint 

7.​ Docking the Cognate Ligand with Hydrogen-Bond and Core Constraints 

8.​ Visualizing Protein-Ligand Complexes 

9.​ Individual Exercise 

10.​Summary, Additional Resources, and References 
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Standards Alignment: 

●​ ACS Guidelines 
○​ Biological macromolecules 

(Section 5.1) 
●​ AAMC MCAT 

○​ Structure, function, and 
reactivity of 
biologically-relevant 
molecules (5D) 

Assessments for Understanding: 

The following types of formative assessments are 
embedded in this lesson: 

●​ Assessment of student understanding 
through discussion of warm-up questions 
and filling in any knowledge gaps about 
structure-based virtual screen steps 

●​ Visual assessment of student-generated 
docking scores from their own set of ligands 

Associated Documentation Pages: Glide Documentation 

Warm-Up Questions:  

Read the article “A systematic analysis of atomic protein-ligand interactions in the PDB” and 

answer the following questions. 

1.​ What are 7 of the most frequent protein-ligand interactions?  

 

 

 

 

2.​ What is the most frequent protein family found in the protein data bank?  

 

 

 

 

 

Need help? Contact us at teaching@schrodinger.com 
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1. Setting Up the Maestro Session 

At the start of the Maestro session, it is essential to 1) check your mouse actions, 2) change 

the file path to the Working Directory for this lesson, and 3) save your project file. The 

working directory indicated in this section contains the files necessary to complete this 

lesson. If you do not set the appropriate working directory, you will be unable to run any 

calculations.  

 
Figure 1-1. Virtual workstation login page. 

1.​ Launch the Virtual Cluster 

 
Figure 1-2. Course-data folder on the desktop. 

2.​ Double-click the course-data folder 
on the desktop 
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Figure 1-3. Copy the lesson folder to the 
Desktop. 

3.​ Right-click the 
protein_ligand_docking folder 
and select Copy to > Desktop 

 

4.​ Double-click the Maestro icon on 
the desktop 

 
Figure 1-4. Change the mouse actions. 

5.​ Check your mouse actions. 
○​ Go to Workspace > 

Customize Mouse Actions 
○​ Note: This lesson was made 

with a three-button mouse 
with a scroll wheel, but a 
trackpad can still be used 

○​ Trackpad keys: 
■​ Up/Down trackpad = 

Zoom In/Out 
■​ Option = Rotate 
■​ Control = Translate 
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Figure 1-5. Change Working Directory option. 

6.​ Go to File > Change Working 
Directory 

 
Figure 1-6. Change Working Directory panel. 

7.​ Navigate to Desktop > 
protein_ligand_docking folder 
and click Choose 

 
Pre-generated input and results files are 
included for running jobs or examining 
output 
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Figure 1-7. Save Project option. 

8.​ Go to File > Save Project As  

 
Figure 1-8. Save Project panel. 

9.​ Change the File name to 
docking_lesson, click Save 

○​ The project is now named 
docking_lesson.prj 
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2. Introduction to Protein Ligand Docking 

As more protein structures are determined experimentally using X-ray crystallography or 
nuclear magnetic resonance (NMR) spectroscopy, molecular docking is increasingly used as 
a tool in drug discovery. Molecular docking is often used to predict the binding mode of a 
small molecule into a protein binding site. Understanding the types of protein-ligand 
interactions gained from docking poses are fundamental in drug design. 

 
Figure 1. Workflow for Protein Ligand Docking 

 
Figure 1 shows a schematic for how to prepare ligand and protein structures, an essential 
first step of modeling. Structure files obtained from the PDB, vendors, and other sources 
often lack necessary information for performing modeling-related tasks. Unfortunately, 
even when working with a high-resolution x-ray crystallographic structure, researchers can 
spend considerable time and effort correcting common problems such as missing 
hydrogen atoms, incomplete side chains and loops, ambiguous protonation states, and 
flipped residues. Additionally, waters that are crucial for ligand binding may also be missing 
from apo binding sites. Why would hydrogens, loops and side chains, as well as waters be 
missing? Let’s break it down: 
 
In crystallography, the X-ray beams are scattered off of electrons, and the only electrons 
around a hydrogen atom are those participating in the covalent bond with another atom. 
Additionally, the resolution of crystal structures tend to be greater than 1 angstrom. This is 
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because of inherent dynamic fluctuations of a protein structure within a crystal and small 
variability between protein structures across different unit cells. However, perhaps this 
issue will be a thing of the past with the advent of new techniques and advancing of current 
methodologies.  
 
Loops and side chains of protein residues can often be missing as well from a protein 
structure – especially crystal and CryoEM structures. There are two reasons for this. The 
first is that these loops or side chains may access multiple different structures in each of 
the molecules in the crystal structure. The average over all of these molecules results in no 
electron density. The second is that even within the crystal structure, these residues or 
loops may be dynamic within each of the molecules that make up the crystals. For similar 
reasons, electron density cannot be observed through scattering. To combat this, we will 
use Prime to construct and add back in missing loops and residues in the lowest energy 
state. Finally, there may be high energy waters that play an important role in ligand binding 
that are not resolved in the PDB structure.  
 
What is extra in protein structures? There are often molecules added in to help aid in 
crystallography that are not biologically relevant. This list of molecules includes small 
organic stabilizing agents like glycerol and metals like Copper and Zinc. Additionally, 
sometimes to help with X-ray diffraction, methionines are replaced with selenomethionines 
since selenomethionines are able to diffract X-rays better with their electron rich outer 
shells of selenium. Finally, if there are any chains in the structures (other proteins that were 
added to stabilize the protein of interest), it might be useful to remove these chains before 
performing docking or structure-based drug discovery.  
 
In order to make these structures suitable for modeling tasks, we use the Protein 
Preparation Workflow to resolve issues. Similarly, ligand files can be sourced from 
numerous places, such as vendors or databases, often in the form of 1D or 2D structures 
with unstandardized chemistry. LigPrep can convert ligand files to 3D structures, with the 
chemistry properly standardized and extrapolated, ready for use for docking. We will go 
into more detail on these Maestro panels and workflows throughout the lesson.  
 
Here, we will reproduce an experimentally observed binding mode of 1FJS, which is a serine 
protease that catalyzes the conversion of prothrombin to thrombin, the first joint step that 
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links the intrinsic and extrinsic coagulation pathways. In this example, the binding pocket 
has an ideal protein conformation to dock the ligand. Docking other screening ligands may 
present itself with more complications since they may prefer binding to a different protein 
conformation. See the lesson on Structure-Based Virtual Screening to learn more. 

3. Preparing Protein Structures for Glide Docking 

Model 

The Protein Preparation Workflow is run within the Preparation Workflow tab. The 
workflow has processing, modification, and refinement tools that we will use on the 
1FJS.pdb structure. This tool is intended to support two main workflows - interactive, single 
protein preparations and highly-automated bulk protein preparations. Interactive 
preparations are manually performed in a step-by-step manner, with the opportunity to 
review the results of each step and easily control the order of modifications. Automatic 
preparation is pre-set by the user by the use of toggles that control which stages of the 
workflow are run in a single job. The Automatic workflow allows processing of multiple 
protein structures in a single job, permitting they maintain the same settings. The 
recommended minimal processing tasks are checked by default in both workflows but may 
be modified using the dropdown options. There are also options for filling in missing side 
chains and/or loops, depending on the needs of your structure. For more information see 
Protein Preparation Workflow Panel Help. 

The Protein Preparation Workflow toggles include Preprocess, Optimize H-Bond 
Assignments, and Clean up. The Preprocess step fixes structural defects and adds missing 
information. The Optimize H-bond Assignment section is used for optimizing the hydrogen 
bonding network – a process that samples water orientations and flips Asn, Gln, and/or His 
side chains at a specified pH value. Adjusting the pH will change the protonation states of 
residues and ligands accordingly and is useful if you want to accurately reflect the 
experimental conditions. The Clean Up section fixes clashes that can occur with adding 
hydrogens or filling missing sidechains. By default, an RMSD of 0.3 Å is used, minimizing 
both the hydrogens and heavy atoms via harmonic penalty constraints. Optionally, 
hydrogen-only minimization can be chosen. 
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The Preparation Workflow tab may be used in conjunction with the Diagnostics tab and 
Substructures tab. These tabs are intended for diagnosis and analysis of the protein after 
preparation steps because automatic procedures cannot cover all possible cases. 

3.1. Prepare the Protein using the Protein Preparation Workflow 
 

 
Figure 3-1. Downloading the PDB file into 
Maestro. 

1.​ Go to File > Get PDB 
2.​ For PDB IDs, type 1fjs 
3.​ Click Download 

○​ 1FJS is loaded into the 
Workspace 

○​ A banner appears 

 
Figure 3-2. Viewing the banner in the 
workspace. 

4.​ Notice that a banner appears in the 
top center of your workspace. 
Banners appear when files have 
been imported, jobs incorporated 
into the Entry List, or to prompt a 
common next step. 

By default the structure corresponding to the imported file is both included in the 
Workspace and selected in the Entry List. Please refer to the Glossary of Terms for the 
difference between included and selected. 
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Figure 3-3. Opening Protein Preparation. 

5.​ Go to Tasks in the upper righthand 
corner of the interface 

6.​ Type protein preparation in the 
search bar 

7.​ Select Protein Preparation 
Workflow - Protein Preparation 
and Refinement 

Note: You can also click Prepare in the banner. Or, you can click on Protein 
Preparation in your Favorites Toolbar. You can add more tools to your Favorites 
Toolbar by starring them in the Task menu. 

 
Figure 3-4. The Protein Preparation Workflow 
in Automatic mode. 

8.​ In the Preparation Workflow tab, 
confirm the INTERACTIVE button is 
off  

○​ When on, the pane will read 
Protein Preparation 
Workflow (interactive) 

Note: INTERACTIVE mode can be used for exploring manual options, or to run a single 
protein in a step-by-step manner. This lesson will be running an automatic protein 
preparation. 
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Figure 3-5. Specify the protein from the 
Workspace. 

9.​ In the Specify Protein section, 
choose use structures from: 
Workspace 

10.​Select Global Settings 
○​ A dropdown opens showing 

the simulation pH and the 
PDB pH as well as small 
molecule options 

11.​Select Review Structure 
○​ The substructures tab opens 

to show Ligands, Metals, 
Other, Waters, and Chains 

The Specify Protein tool provides you with the option to prepare a protein from the 
Workspace, Project Table, File, or directly from the PDB. In this example, the non-water 
solvents option is left unchecked. This saves computational resources because the 
glycerols in our Workspace will not be prepared. 
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Figure 3-6. Review the structure for 
preparation in the Substructures tab. 

12.​Under Chains, click Chain L 
○​ The Workspace zooms to the 

chain 
13.​Click Delete from Entry 

○​ The smaller of the two chains 
is removed, and a new entry 
named 1FJS - with-deletions 
appears in the Entry List. 

Note:  Unless specified, waters and 
glycerols (GOL) belonging to chain L will not 
be removed. Glycerols are a 
crystallographic artifact with no biological 
relevance. The Select dropdown provides 
shortcuts for selecting these species based 
on their proximity to specified chains. 
Removing waters and glycerols will be 
available again in the Clean Up and Analysis 
steps 
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Figure 3-7. View protein issues in the 
Diagnostics tab. 

14.​Select the Diagnostics tab 
○​ Valence errors were found, 

but these bond order issues 
will be resolved in the protein 
preparation 

○​ The Missing tab is empty, 
indicating there are no 
missing side chains in the 
protein structure 

15.​Select Reports to view other issues 
with the protein that must resolved 
prior to modeling 

 

 
Figure 3-8. Preprocess default settings. 

16.​Return to the Preparation 
Workflow tab 

17.​Confirm Preprocess is toggled on 
(colored blue) 

○​ Notice Fill in missing side 
chains is checked by default. 
If these were missing in our 
structure, they would 
become populated during 
this step 

18.​Under Preprocess, select More 
Options 
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○​ Among the options provided, 
notice that missing loops 
may be filled in using Prime 

19.​Check the pH range for generating 
het states with Epik 

○​ This should align with the 
physiological or assay pH. 

Depending on your system and research question, you may want to keep certain waters. 
See the Protein Preparation Workflow Panel Documentation for more details. 

 
Figure 3-9. Optimize H-Bond Assignment 
default settings. 

20.​Confirm Optimize H-bond 
Assignment is toggled on 

21.​Click Settings 
○​ Overlapping atoms caused 

by the addition of hydrogens 
during the Preprocess step 
will be corrected, and side 
chains may be flipped when 
this job is run 

22.​Check the pH for Optimization 
○​ This value should be 

captured in the pH range 
chosen during the 
Preprocess step 

 
16 

 
The recipient shall not use the Schrödinger software, materials and information other than for the purposes for which they were distributed. Schrödinger owns the software and all materials, and retains all related 

intellectual property rights. Schrödinger will retain all intellectual property rights relating to any suggestions, ideas, enhancement requests, feedback, recommendations or other information provided by the 

recipient or any third party.  The recipient shall not use Schrödinger’s names or marks without Schrödinger’s prior written consent. THE SOFTWARE AND MATERIALS ARE PROVIDED "AS IS" WITHOUT WARRANTY OF 

ANY KIND. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL SCHRÖDINGER OR ITS AFFILIATES OR LICENSORS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, CONSEQUENTIAL, 

PUNITIVE OR EXEMPLARY DAMAGES. 

https://www.schrodinger.com/sites/default/files/s3/release/current/Documentation/html/protein_preparation/protein_preparation_help/protein_preparation_workflow.html


Back to Lesson Contents 

 

 
Figure 3-10. Clean Up default Settings. 

23.​Confirm Minimize and Delete 
Waters is toggled on 

24.​Click Settings 
○​ Notice that by default distant 

waters will be removed. The 
specified distance to ligands 
can be modified 

 
Figure 3-11. Naming the job. 

25.​Change the job name to 
1FJS_Prepared 

 
Figure 3-12. Choosing the Job Settings. 

26.​Adjust the job settings (        )  

○​ Host: cpu-preemptible (400) 

○​ Total: 4 processors 

27.​Click Run 
○​ This job requires a 4 CPU 

host and should complete in 
under 5 minutes. All toggled 
jobs are running 
consecutively. 

○​ A new group will be added to 
the Entry List when 
completed 
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Figure 3-12. Select the protein preparation 
output. 

28.​In the Entry List, click on 1FJS – 
prepared 

In Interactive mode, multiple entries will be added to the Entry List as each individual 
preparation task will be run as an independent job. 

 
Figure 3-12. Perform Substructure Review. 

29.​Return to the Protein Preparation 
tool by going to Tasks > Protein 
Preparation, or selecting it from 
your Favorites Toolbar 

30.​Click the Substructures tab 
31.​Choose Load from Workspace 
32.​In the Hets table, shift-click to select 

all GOL rows 
33.​Click Delete from Entry 
34.​In the Waters table, shift-click to 

select all waters 
35.​Click Delete from Entry. This 

creates a new entry in the prepared 
entry group called 1FJS - with - 
deletions 

Note: These waters could have been removed during the Clean Up processing step. 
Depending on your system and research question, you may want to keep certain waters. 
See the Protein Preparation Workflow Panel Documentation for more details. 
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Figure 3-13. Confirm issues have been 
resolved during preparation. 

36.​In the 1FJS_Prepared-out1 group, 
select 1FJS – with-deletions 

37.​Return to the Protein Preparation 
Workflow and click the Diagnostics 
tab 

38.​Click Check Workspace Entry to 
make sure there are no issues 
missed during the preparation.  

39.​Exit the Protein Preparation 
Workflow 

If issues persist after preparation, perform specific interactive protein preparations on 
the modified protein with adjusted settings. The job type will depend on which problems 
were found. 

 

 
 
 
 
 
 
 
 
 
 
 

 
19 

 
The recipient shall not use the Schrödinger software, materials and information other than for the purposes for which they were distributed. Schrödinger owns the software and all materials, and retains all related 

intellectual property rights. Schrödinger will retain all intellectual property rights relating to any suggestions, ideas, enhancement requests, feedback, recommendations or other information provided by the 

recipient or any third party.  The recipient shall not use Schrödinger’s names or marks without Schrödinger’s prior written consent. THE SOFTWARE AND MATERIALS ARE PROVIDED "AS IS" WITHOUT WARRANTY OF 

ANY KIND. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL SCHRÖDINGER OR ITS AFFILIATES OR LICENSORS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, CONSEQUENTIAL, 

PUNITIVE OR EXEMPLARY DAMAGES. 



Back to Lesson Contents 

 

4. Preparing a Ligand Structure 

In this section, we will prepare the co-crystallized ligand from the 1FJS structure for use in 

virtual screening. This is a typical step for cognate ligand docking, as it provides important 

validation prior to screening a larger ligand data set. 

 

The following steps provide an example of how you would prepare a ligand data set using 

LigPrep. Ligand files can be sourced from numerous places, such as vendors or databases, 

often in the form of 1D or 2D structures with unstandardized chemistry. Before being used 

in a virtual screen, ligands must be converted to 3D structures, with their chemistry 

properly standardized and extrapolated.  

 

4.1. Split the prepared structure 

 
Figure 4-1. Renaming from 1FJS - 
with-deletions to 1FJS_prepared_dry. 

1.​ In the Entry List, double click 1FJS 
- with-deletions in the 
1FJS_Prepared-out1 group and 
rename the entry to 
1FJS_prepared_dry 

 

 
Figure 4-2. Right-click to split an entry into 

2.​ Right-click on 1FJS_prepared_dry 
3.​ Choose Split > Into Ligands, 

Water, Other 
○​ Two new entries appear in 

the Entry List 
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different components. 

Figure 4-2. Including 
1FJS_prepared_dry_ligand 

4.​ Include 
1FJS_prepared_dry_ligand  

○​ Only the ligand is displayed 
in the Workspace 

 

 

4.2. Run LigPrep 

Figure 4-3. LigPrep application in the Task 
toolbar. 

5.​ Go to Tasks and type LigPrep in the 
search bar 

6.​ Select LigPrep 
○​ The LigPrep panel opens 
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Figure 4-4. The LigPrep panel. 

7.​ For Use structures from, choose 
Workspace (1 included entry) 

8.​ Under Stereoisomers, choose 
Determine chiralities from 3D 
structure 

 
Figure 4-5. Naming the job. 

9.​ Change Job name to ligprep_1fjs 

 
Figure 4-6. Adjusting the Job Settings. 
 

10.​Adjust the job settings (        )  

○​ Host: cpu-preemptible (400) 

○​ Total: 1 processors 

11.​Click Run 
○​ This job requires a CPU host 

and should complete in 
under 3 minutes 

○​ A new group will be added to 
the Entry List when 
completed 
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Figure 4-7. Manually importing output files if 
they did not automatically incorporate. 

12.​If your entry did not incorporate 
into your Entry List, go to File > 
Import Structures. If it did, skip 
steps 12 & 13 

13.​Go to the folder named ligprep_1fjs 
and open ligprep_1fjs-out.maegz 

The Tile functionality is very useful for seeing the slight variations in chemistry for the 
generated structures. The Tile View can be turned on by clicking the ➕ in the Workspace 
Configuration Toolbar in the bottom right corner and then clicking the Tile button. 
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5. Generating a Receptor Grid with Hydrogen-Bond 

Constraint 
Grid generation must be performed prior to docking with Glide. The shape and properties 
of the receptor are represented in a grid by fields that become progressively more 
discriminating during the docking process. To add more information to a receptor grid, 
different kinds of constraints can be applied during the grid generation stage. For a 
comprehensive overview of constraint options, see the Glide User Manual (Help > Help > 
User Manuals > Glide User Manual). In this tutorial, we will set a hydrogen bond 
constraint in our receptor grid. 

5.1. Identify the binding site  

 

Figure 5-1. Select and include 
1FJS_prepared_dry (Entry #4). 

1.​ Click the In circle next to 
1FJS_prepared_dry to include it in 
the Workspace 

 

Figure 5-2. Double-clicking Presets to render 
the protein structure with a Custom Preset. 

2.​ Double-click Presets 
○​ 1FJS_prepared_dry is 

rendered using the Custom 
Preset 
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Figure 5-3. Toggle off the residue labels. 

3.​ You may toggle off the residue 
labels in the bottom right corner if 
you wish 

 

Figure 5-4. Opening up Receptor Grid 
Generation from the Tasks menu. 

4.​ Go to Tasks and type Receptor 
Grid Generation in the search bar 

5.​ Select Receptor Grid Generation: 
Glide 

○​ The Receptor Grid 
Generation panel opens 

 

Figure 5-5. The Receptor tab of Receptor Grid 
Generation. 

6.​ Under Define Receptor, check the 
boxes for Pick to Identify the 
ligand (Molecule) and Show 
Markers 

○​ A banner in the Workspace 
will prompt you to click on an 
atom in the ligand 

 

7.​ Click any atom on the ligand. The 
ligand is the only molecule in the 
workspace that is in ball-and-stick 
representation. 
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Figure 5-6. Selecting any atom part of the 
ligand highlights the entire molecule with 
green cubes around each atom. 

 

Figure 5-7. Zooming out to visualize the entire 
structure. 

8.​ You may zoom out to visualize the 
entire protein structure using the Fit 
Tools 

 

 

Figure 5-8. The ligand is defined to be 
excluded from grid generation. 

9.​ The ligand is now highlighted in 
green with a purple box around it 

○​ The purpose of this is to 
exclude the ligand from the 
grid generation so it may be 
reused with a variety of other 
ligands for docking of a 
larger ligand library 

Note: The purple bounding box defines the 
region that the docked molecule(s) can 
occupy to satisfy the initial stages of 
docking 
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5.2. Define the bounding box dimensions 

 

Figure 5-9. The Site tab of Receptor Grid 
Generation. 

1.​ Click the Site tab  
2.​ Select Centroid of Workspace 

ligand (selected in the Receptor 
tab) 

3.​ Click Advanced Settings 
a.​ A green inner bounding box 

appears 

Note: The green bounding box defines the 
region in which the centroid of the docked 
molecule(s) must occupy to pass the initial 
stages docking 

 

Figure 5-10. Ligand diameter midpoint box 
panel. 

4.​ Keep the default settings for X, Y, 
and Z sizes the same at 10, 10, and 
10 Å , respectively. 

5.​ Click OK 
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5.3. Set a hydrogen bonding constraint 

 
Figure 5-11. Search in the Structure Hierarchy. 

1.​ Minimize the Receptor Grid 
Generation panel (do not close it) 

2.​ Type L to zoom to the ligand 
3.​ In the Structure Hierarchy under 

the Entry List, click the magnifying 
glass 

4.​ In the search field, type ASP 189 
5.​ Select ASP 189 

According to Adler et al., the salt bridge formed between the inhibitor and Asp189 
observed in the crystal structure of the complex contributes to the potency of the ligand. 
For this tutorial, you will set the constraint for this specific hydrogen bond in the receptor 
grid. Please see the Introduction to Structure Preparation and Visualization tutorial for 
instructions on how to add residue labels and show H-bonds. 

 
Figure 5-12. The Constraints tab of Receptor 
Grid Generation. 

6.​ In the Receptor Grid Generation 
panel, click the Constraints tab  

7.​ Click the H-bond/Metal (0) tab 
○​ A banner appears prompting 

selection of the receptor 
atom to be the constraint 

 
Figure 5-13. Zoom to selected atoms. 

8.​ Under Fit, click Fit view to selected 
atoms 
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Figure 5-14. Turn on the Interactions toggle in 
the workspace toggles. 

9.​ Turn the Interactions toggle on to 
see the non-covalent interactions 
between the ligand and active site 
residues 

 
Figure 5-15. Constraint defined on ASP 189. 

10.​Click an oxygen atom of the ASP 
189 sidechain 

○​ Both oxygens are highlighted 
○​ An H-bond constraint is 

defined in the Receptor 
atoms table 

 
Figure 5-16. Hydrogen-bond constraint is now 
the receptor grid generation job. 

11.​Go back to the Reception Grid 
Generation panel and notice that 
ASP 189 is now listed under the 
H-bond constraint 

12.​Change Job name to glide-grid_1fjs 
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Figure 5-17. Adjusting the job settings  

13.​Adjust the job settings (        )  

○​ Host: cpu-preemptible (400) 

14.​Click Run 
○​ This job requires a CPU host 

and should complete in 
under 2 minutes 

○​ A folder named 
glide-grid_1fjs is written to 
your Working Directory 

Note: All Receptor Grid Generations jobs do not incorporate into the Entry List 
like other jobs have done in the past. Rather, this creates a folder inside of your 
Working Directory with a .zip file that we will use for docking with Glide in the next 
section. 
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6. Docking the Cognate Ligand with Hydrogen-Bond 

Constraint 

The minimum requirements for running a Glide virtual screen are a grid file and a ligand 

file. It is strongly recommended that the grid file be generated from a protein prepared 

using the Protein Preparation Workflow and the ligand file be prepared using LigPrep. 

Additionally, you can choose the scoring function, set ligand- and receptor-based 

constraints, and define the output. Please see the Glide User Manual for more detail. In this 

section, we will include the hydrogen bonding constraint that was created in the previous 

step. 

 

In this section, we will dock the cognate ligand to validate the docking protocol which 

includes the receptor grid and the necessary constraints. The validated protocol can then 

be used for virtual screening of a ligand library. The information gained from this step can 

help with evaluating poses and beneficial interactions, which is useful for hit finding. This 

job will use the receptor grid file that was generated in the previous section. 

 

 
Figure 6-1. Opening Glide Ligand Docking 
from the Tasks Menu 

1.​ Go to Tasks and type Ligand 
Docking in the search bar 

2.​ Select  Ligand Docking: Glide 
○​ The Ligand Docking panel will 

open 

 
Figure 6-2. The Ligands tab of the Ligand 
Docking panel. 

3.​ Next to Receptor grid, click Browse 
4.​ In the glide-grid_1fjs folder, choose 

glide-grid_1fjs.zip and click 
Open 
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Figure 6-3. A window that verifies receptor 
constraints. 

5.​ A new window will appear verifying 
that receptor constraints were 
found in the receptor grid. Click OK. 

 
Figure 6-4. The Constraints tab of the Ligand 
Docking panel. 

6.​ This takes you to the Constraints 
tab. Click on the Receptor tab. 

7.​ Under Use, check the H-bond 
constraint for ASP 189 

 
Figure 6-5. The Ligands tab of the Ligand 
Docking panel. 

8.​ In the Ligands tab, for Use ligands 
from, choose Files 

9.​ Next to File name, click Browse 
10.​Go to the ligprep_1fjs folder and 

choose ligprep_1FJS-out.maegz 
 

 
Figure 6-6. Changing the job name. 

11.​Change Job name to 
glide_1FJS_cognate_Hbond 
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Figure 6-7. Adjusting the Job Settings. 

12.​Adjust the job settings (        )  

○​ Host: cpu-preemptible (400) 

○​ Total: 4 processors 

13.​Click Run 
○​ This job requires a CPU host 

and should complete in 
under 2 minutes 

○​ A new group will be added to 
the Entry List when 
completed 

 
Figure 6-8. View Poses of the cognate ligand. 
The poses are ranked with the best docking 
score at the top.  

14.​Click the icon next to the 
glide-1FJS_cognate_Hbond_pv and 
select View Poses 

15.​In the Pose Viewer panel, select Set 
Up Poses 

16.​The 1fjs_prep_complex entry is fixed 
in the Workspace, the top 
1fjs_prep_lig entry is included, and 
the Pose Viewer panel appears 

You may wish to double click the Presets button to have each ligand represented in a 
unique color.  

 
Figure 6-9. Docking result poses shown 
against  the cognate ligand (gray). 

17.​Include other ligand results  
○​ H-bonds to ASP 189 are 

conserved 
18.​Double-click the In circle next to 

1fjs_prep_complex 
○​ The entry is no longer fixed 

in the Workspace 
 

Note: To view all docked ligands in their 
own color, include all ligands to be 
evaluated and double click the Presets 
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button, or include all ligands and choose 
Binding Mode Comparison in the Presets 
menu. 

 
Figure 6-10. An overlay of the best docked 
pose (pink) with the crystal structure (gray). 

19.​Include the top docked pose (the 
pose with the most negative docking 
score) and 1fjs_prep_lig to compare 
the best docked pose to the cognate 
ligand 

As shown in Figure 6-10, the parts of the ligand that form interactions, including the 
H-Bond at ASP-189, overlap with the cocrystal ligand. However, even in the best docked 
pose (shown in pink), the solvent-exposed region (circled in gray) does not fully align with 
that of the cocrystal ligand. It is not surprising given that the binding pocket of 1FJS is 
solvent exposed and that docking is performed in vacuum. To get a better agreement 
with the crystal structure pose, there are other constraints that can be considered. 
Section 7 focuses on core constraints, which can further improve the alignment between 
the docked poses and the cocrystal ligand. If you would like to go straight to Visualizing 
Protein-Ligand Complexes, go straight to Section 8. 

 

7. Docking the Cognate Ligand with Hydrogen-Bond and 

Core Constraints (optional) 
You may have noticed that only using a hydrogen-bond constraint does not exactly 
reproduce the cocrystal pose – the “unmatched” section is in the solvent-exposed region. In 
this section, you will add another constraint to better align the docked pose to the pose 
from the crystal structure. 
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Figure 7-1. The Ligands tab of the Ligand 
Docking panel remains the same as before. 

1.​ Include and select 
1FJS_prepared_dry 

2.​ Go to Tasks and search Ligand 
Docking 

3.​ Select Ligand Docking: Glide 
4.​ The Ligand Docking panel opens 
5.​ Keep glide-grid_1fjs.zip as 

the receptor grid 
6.​ Keep ligprep_1fjs-out.maegz 

as the Ligands to be docked file 
 

 
Figure 7-2. The H-bond Constraints tab of the 
Ligand Docking panel remains the same. 

7.​ Go to the Constraints tab. Click on 
the Receptor tab. 

8.​ Under Use, check the H-bond 
constraint for ASP 189 

 
Figure 7-3. The Core Constraints tab of the 
Ligand Docking panel. 

9.​ Go to the Core tab 
10.​Check mark Use core pattern 

comparison 
11.​Under Define core, check Pick 

core-containing molecule 
12.​Minimize the Ligand Docking panel 
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Figure 7-4. Picking an atom part of the ligand 
for the core constraint. 

13.​In your Entry List, select and include 
1fjs_prepared_dry 

14.​Click on the ligand 

 
Figure 7-5. Naming and running the job.  

15.​Go back to the Ligand Docking 
panel 

16.​Change Job name to 
glide_1FJS_cognate_Hbond_core 

17.​Click Run 
○​ This job takes about a minute 
○​ A banner appears to show 

that files have been 
incorporated 

○​ A new group is added to the 
Entry List 

 
Figure 7-6. View Poses of the cognate ligand 
with constraints. 

18.​Click the icon next to the 
glide-1FJS_cognate_Hbond_core_pv 
and select View Poses 

19.​In the Pose Viewer panel, select Set 
Up Poses 

20.​The 1fjs_prep_complex entry is fixed 
in the Workspace, the top 
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1fjs_prep_lig entry is included, and 
the Pose Viewer panel appears 

○​ You may wish to double click 
the Presets button to have 
each ligand represented in a 
unique color. 

 
Figure 7-7. Binding poses of the top docked 
cognate ligands compared to the crystal 
structure. 

21.​Include other ligand results  
22.​Double-click the In circle next to 

1fjs_prep_complex 
○​ The entry is no longer fixed 

in the Workspace 
Note: To view all docked ligands in their 
own color, include all ligands to be 
evaluated and double click the Presets 
button, or include all ligands and choose 
Binding Mode Comparison in the Presets 
menu. 

Now all the results from docking perfectly align with the cocrystal pose. You can use 
core constraints if the screening ligands have the same binding mode and have a 
similar core constraint to the cocrystal ligand.  

 
 

8. Visualizing Protein-Ligand Complexes 

In this section, we will explore ways to visualize structures in the Workspace. Object 
representation can be changed in a number of ways using the Style toolbox. Presets offer 
the ability to quickly render a structure in a number of styles, similar to PyMOL, to facilitate 
easy visualization. Presets can be used in a variety of ways, from de-cluttering your 
structure to creating publication-quality images. We will analyze the protein-ligand complex 
by looking at the interactions, and generate a custom set for some binding residues of 
interest. Finally, we will visualize the surface of the binding pocket and l save an image of 
the complex. 
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8.1. Use the Style toolbox 

 
Figure 8-1. The Style toolbox with CPK 
representation highlighted. 

1.​ Include entry 1FJS – prepared  
2.​ Type L  

○​ The Workspace zooms to the 
ligand 

3.​ Under Quick Select, click L  
○​ The ligand is selected 

4.​ Click Style  
5.​ Choose CPK representation  

○​ The ligand is rendered in 
space-filling (CPK) 
representation 

○​ This is only applied to the 
ligand, since nothing else is 
selected in the Workspace 
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Figure 8-2. The Color Atoms menu. 

6.​ Click the Color Atoms arrow 
7.​ Choose Element (Custom Ligand), 

and pick orange from the secondary 
menu 

○​ Ligand carbon atoms are 
orange  

8.​ Under Quick Select, click P  
○​ The protein is selected 

9.​ Type Z  
○​ The Workspace is zoomed to 

view the selected structure 
10.​In the Style toolbox, click Ribbons 

○​ Ribbons are added to the 
protein 
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Figure 8-3. The Edit Ribbon panel. 

11.​Right-click on the ribbon 
○​ The Edit Ribbon panel opens 

 
Note: Use the predictive highlighting to 
know when you will click on the ribbon. 
 

12.​Click Residue position in the color 
scheme 

13.​Choose Single Color 
 
Note: Click the box to the right of the color 
scheme to choose different colors 
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8.2. Use the Style toolbox 

 
Figure 8-4. The Presets menu. 

1.​ Click Presets  
2.​ Choose Pretty 

○​ The Workspace is rendered 
with ribbons, a green 
thick-tube ligand, and side 
chains are hidden 

3.​ Double-click Presets  
○​ The Workspace is redrawn 

with the Custom Preset 
○​ The Workspace zooms to the 

ligand 

 

8.3. Visualize Interactions 

 
Figure 8-5. The Interactions panel in the 
Workspace Configuration Toolbar. 

1.​ In the Workspace Configuration 
Toolbar, click the 3 dots above 
Interactions  

○​ The Interactions panel opens 
2.​ Turn on Non-covalent bonds 
3.​ Turn off Pi-cation interactions 

 
Note: Clicking the color to the right of each 
interaction opens the Preferences panel, 
where the interaction visualization can be 
customized 
 
Note: The threshold for Contacts/Clashes 
is set to 0.89 for bad and 0.75 for ugly. 
These values correspond to the ratio of the 
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distance between the two atoms and the 
sum of their Van der Waals radii. 

 

8.4. Generate and manipulate a surface 

 
Figure 8-6. More options in Quick Select. 

1.​ Under Quick Select, click … and 
choose Binding Sites 

2.​ Click Style and choose Surface 
○​ A solid gray surface is applied  
○​ An S is next to the title in the 

Entry List, click to see surface 
options 

 
Note: Click  Surface (Binding Site) in the 
Favorites toolbar to perform the same task 

 
Figure 8-7. The Surface Display Options panel. 

3.​ Right-click the surface 
4.​ Choose Display Options  

○​ The Surface Display Options 
panel opens 

5.​ For Color Scheme, choose 
Electrostatic Potential 

6.​ Change the Min and Max values to 
-0.1 and 0.1, respectively 

7.​ Click OK 
○​ The intensity of the surface 

colors is increased  
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8.5. Generate a 2D interaction diagram 

 
Figure 8-8. Ligand Interaction Diagram in the 
Favorites toolbar. 

1.​ In the Favorites toolbar, click Ligand 
Interaction 

a.​ The 2D Workspace - Ligand 
Interaction Diagram opens 

 
Figure 8-9. The Ligand Interaction Diagram 
with Sync with 3D turned on and LID legend 
open. 

2.​ Check mark Sync with 3D and 
rotate the ligand in the Workspace 

a.​ Ligand orientation is changed 
in the 2D representation 

3.​ Click the cog/gear symbol > LID 
Legend 

 
Note: Images can be saved via File > Save 
Screenshot 
 
Note: The residue icon point indicates the 
direction of the sidechain 
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9.​ Individual Exercise 

Part A: 

Perform the same preparation steps on the 2XIR crystal structure. What were some of the 

issues with this PDB structure from the first step of protein preparation? 

 

 

 

 

 

 

 

Part B: 

Search the Protein Data Bank for another protein-ligand complex and do the following: 

 

A.​ Import the .pdb file into Maestro 

B.​ Split the structure into Ligands, Waters, and Receptor 

C.​ Prepare the protein using the Protein Preparation Workflow 

D.​ Prepare the ligand using LigPrep 

E.​ Detect the binding site using Receptor Grid Generation 

F.​ Dock all the conformations and tautomers generated from LigPrep back into the 

prepared protein using Schrödinger’s Glide 

G.​ Take a screenshot of your docking results including the docking score and pose of 

the best docking pose. 

 

 

 

 
44 

 
The recipient shall not use the Schrödinger software, materials and information other than for the purposes for which they were distributed. Schrödinger owns the software and all materials, and retains all related 

intellectual property rights. Schrödinger will retain all intellectual property rights relating to any suggestions, ideas, enhancement requests, feedback, recommendations or other information provided by the 

recipient or any third party.  The recipient shall not use Schrödinger’s names or marks without Schrödinger’s prior written consent. THE SOFTWARE AND MATERIALS ARE PROVIDED "AS IS" WITHOUT WARRANTY OF 

ANY KIND. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL SCHRÖDINGER OR ITS AFFILIATES OR LICENSORS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, CONSEQUENTIAL, 

PUNITIVE OR EXEMPLARY DAMAGES. 



Back to Lesson Contents 

 

10.​ Summary, Additional Resources, and References 
In this lesson, we imported and prepared a protein and ligand file, then visualized and 

analyzed the protein-ligand complex. A raw PDB file was made suitable for modeling 

purposes using the Protein Preparation Workflow, and the cognate ligand was extrapolated 

using LigPrep in the same fashion that would be used for a multi-ligand file. Then the 

prepared ligand was docked into the prepared protein using Glide. The Workspace 

Configuration toolbar allowed for toggling various components in the Workspace and the 

2D view in the  Ligand Interaction Diagram gave another way to analyze information. 

 

For further learning: 
●​ Target Analysis with SiteMap and WaterMap 

●​ Structure-Based Virtual Screening using Glide 

●​ Ligand-Based Virtual Screening Using Phase 

●​ Introduction to Molecular Modeling in Drug Discovery Online Course 

●​ Target Enablement, Preparation, & Validation Online Course 

11.​ Glossary of Terms 
Entry List - a simplified view of the Project Table that allows you to perform basic 
operations such as selection and inclusion 

Included - the entry is represented in the Workspace, the circle in the In column is blue 

Project Table - displays the contents of a project and is also an interface for performing 
operations on selected entries, viewing properties, and organizing structures and data 

Recent actions - This is a list of your recent actions, which you can use to reopen a panel, 
displayed below the Browse row. (Right-click to delete.) 

Scratch Project - a temporary project in which work is not saved. Closing a scratch project 
removes all current work and begins a new scratch project 

Selected - (1) the atoms are chosen in the Workspace. These atoms are referred to as "the 
selection" or "the atom selection". Workspace operations are performed on the selected 
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atoms. (2) The entry is chosen in the Entry List (and Project Table) and the row for the entry 
is highlighted. Project operations are performed on all selected entries 

Working Directory - the location that files are saved 

Workspace - the 3D display area in the center of the main window, where molecular 
structures are displayed 
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